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Installation
The Thunderbird ES6000 is a complete data logger for all your weighing needs. It’s capable of
storing information on up to 50,000 animals, with 10 weighings sessions on each animal, This
information can be displayed at the weighing site, thereby eliminating the need for a computer in
the field.

Installing the Load Cells
Locate a weighing site that is well drained. For best weighing results, ensure the weigh bars and
weighing platform are on a level hard surface (ie concrete), and free from contact of any
obstruction. Do not use wooden platforms. Make sure the platform doesn’t rock, pack with
spacers if needed to eliminate rocking. If the installation has any flexing or twisting in the
platform, inaccurate weights may occur. The weight should be evenly distributed over the top of
the weigh bars.
When bolting the bars down, also eliminate any twisting of the platform. Avoid bolting
everything down tight. If in a fixed situation, it is best practice to bolt the rear bars to the
concrete, then bolt the platform or crush to the bars, leaving the front bars unbolted with only
guide pins into the concrete. This will minimise any flexing and stress that could occur.
When weighing animals, be sure that their weight is totally on the weighing surface, and not
touching fixed gates, rails, etc. If at all possible use a crush or weigh box, and place the weigh
bars so that the whole structure is weighed. This will eliminate weighing errors if the animal
does lean on any part of the structure.

Care and Maintenance
WARNING! DO NOT WELD TO THE WEIGH BARS OR ANY STRUCTURE THAT
THEY ARE ATTACHED TO. The voltage and current from the welder can instantly destroy
the sensitive strain gauges used to measure the weight. Welding voltages and currents create
observable damage to the strain gauges, and will void your warranty. Remove the weigh bars
from the structure before attempting to weld.
Keep connections dry. Moisture in the plugs and sockets is the leading cause of eratic and
drifting weights. The signal from the weigh bars is incredibly small, measured in millionths of a
volt. The conductive moisture plays havoc with this type of signal. If moisture does enter a
connection, dry thoroughly and wipe in between the connector pins with a dry cloth to remove
any residue. Make sure the plug cover is fitted over the end of the plug when disconnected from
the indicator.
Care of cables is important to avoid erratic readings or breakdown. Plugs should be covered
when not in use to avoid corrosion of contacts and to prevent moisture penetrating the cables.
Hang the cables on the weigh box or push them under the weigh box when not in use so that an
animal cannot accidently walk on them.
3

Do not allow the bars to remain wet or allow a build up of manure inside the bars for long
periods of time. This will shorten the life of the weigh bars, can cause premature failure and
may void your warranty. If the area does remain wet, remove the weigh bars when not in use.
The weigh bars are sealed, and can be hosed out with low pressure water to keep clean.
Store the indicator in a dry area away from moisture when not in use. Although it has a
gasket seal to prevent rain ingress, repeated cycling of warm and cool from day to night in a
damp area can cause a build up of condensation inside the indicator.
Do not transport weigh bars or load cells with a weight on them. If the vehicle goes over a
bump, the resulting “G” forces increase the effective weight applied, which may exceed the load
cell capacity, causing damage to the load cells. Load cells that have had excessive weight applied
to them are not covered by warranty.
Do not leave the charger connected to the indicator and switched on indefinitely. The life
of the Ni-MH battery will be shortened considerably by continuous charging. Only charge for
15-18 hours at a time.
Charge the internal battery at least every month. The internal Ni-NH battery must be
regularly charged to maintain its function. The battery may fail if it is not regularly charged.

Power Supply
The ES6000 comes with an internal Ni-MH battery. The indicator will need to be connected to
the charger overnight before use. The charger must be connected for approximately 15 hours
to fully charge the battery. If, however, weighing must be done immediately, connect the 12V
battery cable into the indicator and then the red clip to the positive of a 12V battery, and the black
clip to the negative of the battery. The indicator automatically turns on. The indicator is diode
protected, so accidental incorrect polarity will not destroy the unit. However if the weigh bars
are electrically connected to the battery, the protection diode may be bypassed. Make sure that
the weigh bars are isolated from the battery. That is, don’t sit the weigh bars on a tractor
trailer or ute, and then power the indicator from that vehicle’s battery. It may damage the
indicator.
The scale will operate for approximately 8 - 12 hours on it’s own battery, depending on the
number of weigh bars attached and provided the battery is fully charged. A plug pack charger is
supplied. The internal battery will also charge from a connected external 12V battery.
There is a battery indicator on the display which looks like a small battery. This icon refers to the
battery from which it is operating. If an external battery is connected, this icon refers to it. If
there is no external 12V source, the icon refers to the internal battery. The battery icon becomes
emptier as the battery voltage drops. If the battery voltage starts getting low, this icon will start
to flash. Once the battery voltage falls to less than an estimated 10% capacity, the indicator will
turn off.
If the internal battery should go flat while weighing, an external 12V battery can be connected to
continue the weighing session. The internal battery will start charging from this external power
source while weighing is in progress.
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NOTE: If the internal battery is flat, leave the external battery connected for a couple of seconds
after turning the scale off to ensure that all data is saved to permanent memory. Statistics data
and other data may be lost if the battery is simply disconnected.

Tips for Accurate Weighing
The ES6000 indicator and Thunderbird load cells incorporate the latest electronics and high
quality sensors. Proper installation and the correct selection of load cell capacity will ensure an
accurate weight. Incorrect installation is the leading cause of inaccurate or changing weights.
Listed are some guidelines to follow that will help you achieve the most from your system.
- Make sure the load cell is attached to a solid structure or surface. Use a level
concrete slab to mount load bars, or a sturdy, rigid frame if suspension load cells are used.
- Use a rigid weigh box or crush to weigh animals, and place the load bars underneath the
whole structure. If you simply place a platform in an existing race, the animal can lean on
the walls of the race or the rump bar, which transfers some of its weight to the race instead
of the platform.
- Select the correct capacity load cells. Weighing is more accurate if the maximum
anticipated weight placed on load cells is closer to their rated capacity. If you are weighing
sheep or pigs, use 200 or 500kg capacity load cells, if you are weighing fleece use 50 or
100kg capacity load cells. Don’t forget to include the weight of the weigh box in your
calculation. This rule applies to all weigh scales on the market. You don’t see
supermarkets weighing fruit and vegetables on 500kg capacity scales.
- Make sure there is no twist in the structure. Any twist will introduce torsion in the load
cells and cause inaccuracies. When mounting the load bars onto the concrete, check for
any diagonal rocking motion. If there is any, place shims such as washers underneath the
load bar to eliminate the rocking motion. Similarly when the structure is placed on the load
bars. Shim any diagonal rocking motion out so that it’s stable.
- Ensure that all mounting holes line up correctly. If a hole in the bar doesn’t quite line
up with what you are mounting to, don’t force it to line up, it will introduce forces onto the
sensors and cause errors. Re-drill the hole if necessary so that the bolt will go in easily.
- If using load bars, don’t bolt everything down tight. Only bolt the rear bars down, and
just have pins securing the front load bar. This will allow the structure to move slightly due
to temperature or other forces, and not put that expansion force onto the load sensors.
- Fit the caps on the plugs when not in use. Moisture is by far the major cause of drifting
weights.
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Layout
The ES6000 has a graphic display and a qwerty type keypad. Its concept is to have a changing
display depending on the operation.

Arrow keys
F keys

Figure 1
There are numerous different displays that can appear. Some are described in detail in these
instructions, others are self explanatory. Always note the F key assignments as described below
and you will be able to easily navigate your way through the system. In almost all situations you
will be able to return to the previous display or the main menu by the press of a button.
Figure 1 shows the layout of the keys. The On/Off button turns the indicator on or off as
indicated. The alphanumeric keys allow easy data entry when needed.
Most of the display functions use the 6 “F” or function keys just underneath the display. These
are “soft” keys, in that they don’t have a fixed function. Their function will depend on the
display being shown, and will assigned by the word above the key on the bottom of the display.
If one or more of the F keys doesn’t have an assignment above it, that key won’t do anything.
The 4 arrow keys to the right of the display allow you to position the cursor at various parts of
the screen, again depending on the display being shown. In some displays one or more of these
keys won’t do anything, but in general if there is more than one parameter that can be changed on
the display, the arrow keys will allow you to move between parameters.
The HOLD button freezes the weight on the display. It will remain frozen until HOLD is pressed
again. It allows you to still view the weight after the object or animal has left the weigh station.
The TARE button zeroes the weight display. Any weight existing on the load cells when the tare
button is pressed will be cancelled and the display will show zero. The display will show the
actual weight of any object placed on the load cells from this time.
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When the indicator is turned on, it goes through a self test procedure. The display will show a
series of numbers progressing across the screen as each individual test is done. If for some
reason the indicator was turned off during the calibration procedure last time, the calibrate screen
will be shown. See page 29 to go through the calibration procedure.
Once the self test is successul the date will be asked for. Enter the date in the format shown on
the display, and weighing can begin. The date entry anticipates the month entry. For example, if
the month is February, simply pressing “F” will cause the entire “FEB” to be displayed.
The main menu will be displayed next, as shown in figure 2. The main menu determines which
operating mode the ES6000 should enter. See below on the different selections in the main
menu.

Figure 2: Main Menu
If livestock weighing is to be recorded based on the ID, a file number will be asked for, and the
current file number will be displayed. Enter another file number, or use the same file number by
simply pressing ENTER.
The drafting information screen will be shown next if drafting is to be done. Enter the desired
drafting data and press ENTER when complete. Figure 10 on page 24 shows the draft menu
display.
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Thundersoft Software
Important Note - The ES6000 requires a serial port on the computer for communication. If your
computer doesn’t have one, you will need to purchase a serial card, an Express to RS-232 adaptor
or USB - RS232 adaptor and install it. See page 9 on adding a serial port to your computer.
Several new features have been included in this software that weren’t in previous versions.
Among the features are:
- An entire history of the weigh sessions of each animal is recorded and displayed.
- Records for sold and deceased animals are kept for reference.
- Total weight gain and daily weight gain is displayed.
- Records can be sorted according to any field.
- Records from individual or multiple file numbers can be displayed.
- The displayed data can be tailored to your own preference.
The Thundersoft software operates on a permanent database. All weigh sessions for each animal
are kept, even after the animal is sold or dies, until the animal is deliberately deleted. This allows
you to keep a breeding record and compare different blood lines for growth rate if you wish to do
so.

Software Installation
A CD is supplied with the ES6000 containing the Thundersoft software. This software allows
communication between the ES6000 and a computer.
Insert the CD into your PC. If autorun is enabled the software installation should start automatically. Otherwise, explore the CD and double click on “Thunderbirs2Installer”. Follow the
prompts on the screen.
The software is now ready to run.
Note: Thunderbird strongly recommends that you download a file that matches your RFIDs and
NLIS IDs from the NLIS website before the first use of this software. To do this:
1. Go to www.nlis.com.au and log in. If you aren’t registered, follow the instructions on
the website on how to register.
2. Choose the fields RFID and NLIS ID and save the file to your hard drive. Remember
where you saved it!

Getting Started
When you run first run Thundersoft 2 you will be met with a blank screen. Follow these steps to
get going.
1. If this is the first time you have run Thundersoft, it is strongly advised that you go to the
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NLIS website and download your RFID-NLIS ID matching file. Save it where it is easily
available, such as the My Documents/Country Electronics folder.
2. For first time use and any time you download an updated tag number match file, click
on “Tools > Import Files > NLIS-RFID Tags”.
3. In the “Look In” box, select the folder that you saved the tag matching file in.
4. Select the file then click open. The animal data will now be displayed.
5. The data will always default to the same format when Thundersoft is first started. You
will have to re-sort the data if you view the data in a different arrangement.

Importing Files
Thundersoft can import a couple of different file types of animal records. The most common will
be the NLIS tag bucket file as described above. You should regularly import the latest tag
number matching file, especially if animals are often bought and sold.
If you are upgrading from a Thunderbird Ultrascale, Thundersoft can import your old animal
records and incorporate them into its database.
To import a file:
1. Click on “Tools>Import Files” then click on the desired file type.
2. Select the file, then click “Open”. The data will be imported.

Adding a Serial Port to Your Computer
All new laptop computers and some new desk top computer no longer have an RS232 serial port.
Most devices now use USB. However USB is not suitable for communication at the yards
without a computer. The reason is that the USB protocol requires a master and designated slaves
for communication. All scales and readers are designated slaves according to the USB protocol,
and 2 slaves cannot communicate with each other. RS232 protocol doesn’t have any of these
restrictions, which makes it ideal for communication between any 2 devices.
If your computer doesn’t have a serial port, there are 2 main ways to add a serial port to your
computer.
1. Use a USB - RS232 adaptor. A USB - RS232 adaptor is the easiest and the cheapest for
laptops, but they are not always reliable due to protocol differences. Use the installation
disk that comes with the USB - RS232 adaptor before plugging into your computer,
otherwise the adaptor may not work. Follow the instructions that come with the adaptor to
install it. Once it’s installed, select the correct “COM” number in the Thundersoft
communication window. Don’t use COM 3, this is your internal modem port.
2. Add a physical RS232 port to your computer. This is the most reliable way to
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communicate via RS232.
a) For a desk top computer, serial PCI cards are available at very low cost. These
cards are available from Thunderbird if your local computer store doesn’t have one,
part No. CS-9850S. They are easy to put into your computer and don’t require any
installation disk.
b) For a laptop, most laptops have a slot in the side for add on cards. There are 2
types of slots; PCMCIA in older style laptops, and Express slots in newer laptops.
Consult your laptop manual to determine which type your laptop has. Serial cards to
go into these slots are available from Thunderbird if your local computer shop
doesn’t have them. The serial card part No. is CS-EXPRESS-RS232. We do not
supply serial cards for the PCMCIA slots.
See page 40 for a flow chart if you have problems with setting up the serial communication.

Communicating With the ES6000
Note: Thunderbird strongly recommends that you upload the database containing the tag bucket
file to the ES6000 BEFORE doing any weighing.
Uploading the data to the ES6000 is a simple process. Abbreviated instuctions are shown on the
Thundersoft communication window.
1. Connect the ES6000 to the serial port of the computer and turn it on.
2. Enter the date on the ES6000 as described on page 14.
3. When the main menu appears, select option 5. The ES6000 is ready to communicate.
4. Click “Talk to ES6000” on the Thundersoft menu line.
5. Select the connection settings, and “from PC to device”, then press “Upload from PC to
device”. The animal records will be transferred.
Warning! All existing records and weights are deleted in the ES6000 when an upload occurs. If
you have information in the ES6000 that’s not in the Thundersoft database, do a download before
uploading any information.
Downloading data from the ES6000 to the PC is equally as simple.
1. Connect the ES6000 to the serial port of the computer and turn it on.
2. Enter the date on the ES6000 as described on page 14.
3. When the main menu appears, select option 5. The ES6000 is ready to communicate.
4. Click “Talk to device” on the Thundersoft menu line.
5. Select the device as ES6000, connection settings, “from device to PC”, and either
changed records or all records, then press “download from device to PC”. The records will
be transferred.
Note: If you delete an animal in Thundersoft and it remains in the ES6000, the Thundersoft
software will reject it when the next download occurrs.
Tip: Once you have gained confidence in the upload (and download), you might like to increase
the baud rate to 57600 on both the PC and ES6000. This will speed up the communication,
especially if there are a lot of animal records to transfer. The baud rate can be changed by
selecting option 1 in communication mode. See page 32 for more information.
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Communicating With the PR20
The Thundersoft software can communicate directly with the Thunderbird PR20 tag reader. The
animal ID doesn’t have to be recorded by the ES6000 to have a permanent record. This is of
great advantage, in that all animal records can be kept on the one database.
For example, you might want to pregnancy test a group of animals, but not weigh them. The
pregnant animals can be recorded in a file on the PR20, which can be then downloaded onto the
database. A code and/or comment can be included with these animals which will be recorded
against each of the animals, along with the date that they were tested.
Note: Thunderbird recommends that you upload the database containing the tag bucket file to the
PR20 before doing any recording. If this is done, the PR20 will display the VID (NLIS ID) so
that the correct animal entry can be confirmed.
Uploading the tag bucket file to the PR20 is straightforward:
1. Connect the PR20 to the serial port of the computer and turn it on.
2. When the PR20 asks for a file number, just press ENTER.
3. Make sure the PR20 is displaying “READY”.
4. Click “Talk to PR20” on the Thundersoft menu line.
5. Select the connection settings, and “from PC to device”, then press “Upload from PC to
device”. The animal records will be transferred.
Downloading is a little more involved, in that extra data needs to be entered. Only one file can
be downloaded at a time. This is because the Thundersoft software assigns the same comment to
all of the animal IDs in that file. In this way you can have several different files, each with a
different purpose. For example, file 5 might be for the pregnant animals, and file 14 could have
the animals that were unloaded off a truck onto the property. File 7 might have the animal that
died in the back paddock. To download:
1. Connect the PR20 to the serial port of the computer and turn it on.
2. When the PR20 asks for a file number, just press ENTER.
3. Make sure the PR20 is displaying “READY”.
4. Click “Talk to PR20” on the Thundersoft menu line.
5. Select the connection settings and “from device to PC”
6. Select the file number that you wish to download.
7. Select the reason for the download.
8. Select the date from the calendar. It doesn’t have to be today’s date.
9. Enter any code or comment you might want to add.
10. Finally, click on “Download from device to PC”. A new line will be created in the
database for each animal in the file recording all the details entered.
Note: An asterisk will be the first character in the comment field for each animal. It let’s you
know that this data came from the PR20, not the ES6000. It is important this asterisk
remains, as the Thundersoft software uses this to indicate that it was a PR20 download, not an
ES6000, and so doesn’t use the weights and weight gains on these lines for calculations.
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Editing Animal Details
You can edit most of the fields in the highlighted animal record by clicking on the “Edit animal
details” button. This action causes an edit window to be displayed.
There are a couple of limitations when editing the animal record. They are:
1. You cannot change the date weighed or the weight. These parameters have been
determined at the time of weighing, and should not be altered.
2. You should not change the NLIS ID without changing the RFID, and vice versa. These
IDs are a matched pair, so one shouldn’t be changed without the other.
3. The data in the “sex” field can be any character, but not a number.
Aside from these restrictions, other fields may be changed at will. The status of the animal can
also be changed in this window. Note that when the status is changed to dead or sold, the record
doesn’t disappear from the database. The “delete” button must be pressed to remove the animal
record from the database.
Multiple records can be edited at the one time. The required records can be selected by holding
down the ‘Control” key as you select them, or by holding down the “Shift” or left mouse button
key while dragging the cursor down the list. When you click on “Edit animal details”, a window
appears with the common fields that can be changed.
The box on the left of the field in the edit may animals window must be clicked on to allow the
change to take place. If this isn’t done the field data won’t be changed in the database.
Once the fields have been changed, click on the “Save Changes” button to update the database.

Reporting Sales
Any animals with an NLIS tag that leave or enter your property or have died must be reported to
the NLIS. The need to report animals that leave your property is in case the person who buys the
animals might neglect to report, and if some disease or contamination is found on them, you have
the evidence of when they left your property. The Thundersoft software can generate a text file
that can be emailed to the NLIS. You will need to know your property code, the property code to
where they are going or where they come from, and a vendor declaration.
Creating a report only takes a few minutes. To create a report:
1. Highlight the animal or animals you want to report on the Thundersoft main screen.
2. Click on edit animal details, which will bring up a new window.
3. Click the status selection, then on the desired “sold” or “dead” button at the bottom.
Enter the property codes and vendor declaration number.
4. Click on the “save changes” button. This will save the status of the animal to the
database and close the window.
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5. Click on “report sales” on the menu bar at the top, which opens another small window.
6. Choose when you want the reported animals to be from, and the date if selecting after a
certain sold date.
7. Save the created file. Remember where you saved the file.
8. Email the NLIS and attach the file to the email.
The animal records will remain on the database, and you will be able to see when and where you
sold them at all times. You will have to delete these records if you no longer require them.

Manually Adding Animals to the Database
You can manually enter a new animal record at any time to the database. To do this:
1. In the top menu bar, click on “Edit>Add animals”. This will open a new window to
enter the details of the animal.
2. Enter the details of the animal, then click “Add animal”. The new record will be added
to the database. If you want to add another animal. click on “New animal”.
Once the animal(s) have been added, you will need to click on “select display” again to update
the sceen information from the database.

Reports
The Thundersoft software can display a variety of reports. They are sold livestock, deceased
livestock, sales history, and deceased history.
Click on “Reports”, and select the report you desire.
You can also use the “Extended Search Options” button to display a whole variety of reports
based on the file number and animal data.

Exporting Data
The Thundersoft software can export a .csv file of animal records. A .csv file can be opened in
Microsoft Excel to be viewed and edited, or printed.
Click on “Reports” in the upper menu bar, then “Export Grid to CSV”.. A file save window will
open, where you can select the folder and enter a different file name if you wish.

Printing Data
Animal data can be printed by clicking on the “Export Grid” button. This will transfer the data to
a program called Crystal Reports, which will allow you to print the animal data that is displayed
in the grid. You can use the “Extended Search Options” button to select which data you want
printed before exporting the grid.
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The Thundersoft data can also be printed using Excel. You must first export the data out of
Thundersoft (see Exporting Data), which creates a .csv file. This .csv file can be opened in
Excel.
Start Excel, go to File->Open, and a window will appear. Select the folder that you save the .csv
file in, then in the “Files of Type” box at the bottom of the window select .csv, and your file
should appear. Click on it then click on “Open”. You may need to adjust the width of the
columns to see all of the data. Arrange the data how you want to print it, then select print in
Excel.

Maintaining the Database
A backup of the Thundersoft database should be a regular task, and the backup saved to some
form of media external to your computer, in case your computer fails or the hard drive gets
corrupted. The records on the database are a complete weight history of all your animals, and
losing this data could be costly.
To make a backup:
1. Click on “File>Backup Database”.
2. A save window will open. Choose the folder and filename, then click Save”.
3. Once a save is done, copy this file to a CD or DVD, or an external hard drive. If
anything happens to your computer, you will be able to restore the Thundersoft database from this
backup.
Restoring the Thundersoft database from a backup is a simple process. To do this:
1. Insert the source of the backup in the computer.
2. Click on “File>Restore Database”
3. A file open window will appear. Choose the filename of the backup, then click open.
The database will be restored to what it was at the time of the backup.
Warning! If a restore is done, any changes made or records added to the database after the
selected backup will be lost!
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Operation
Make sure the battery is charged overnight before use!
It is strongly recommended to upload your NLIS “tag bucket file” into the ES6000
BEFORE doing any weighing.
You will find that the ES6000 is remarkably easy to navigate around the various functions and
menus. Extensive use is made of the 6 “F” keys. These are the 6 keys directly underneath the
display. Their function will be displayed on the screen just above the key, and will change
depending on the information on the screen and the position of the cursor.
Turn the indicator on by pressing the ON/OFF key. The unit will ask for the date.

Date Entry
Figure 3 shows the date entry screen.

Figure 3: Date entry display

The date must be entered in the MMM/DD/YY format as shown by the example on the screen.
This date format was chosen to avoid confusion over days and months in a date, such as 10/12/
07. The ES6000 anticipates the month by looking at the key that was pressed, and fills in rest of
the month if possible. For example, if “S” is pressed, all of SEP will be displayed, however if “J”
is pressed it must wait for addition text to interpret the month. This feature is to aid in the month
entry, and ensure that the ES6000 understands the month entered.
Use the left arrow as a backspace if an incorrect key has been pressed.

Main Menu
There are 2 versions of the main menu. When the indicator is first turned on, only the operating
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mode will be asked for. There will be no F key assignments. During normal operation the main
menu can be called up at any time, and assignments given to the F keys. These assignmnts will
lead you into the menu assigned to the particular F key.

Figure 4: Main Menu
There are 5 modes of operation of the ES6000. These operation modes determine the parameters
that control the operation of the ES6000. The operating mode is selected when the ES6000 first
turns on, and can be changed at any time. It can also change automatically when certain other
parameters are altered during weighing, such as drafting and weighing mode. The last operating
mode is remembered however, so if the changed parameter is return to it’s original setting, the
operating mode will also return to the original setting. The 5 operating modes are:
Weight only - The scale acts as a basic device in this mode, in that no individual weight
recording is done. Statistics can be gathered on the overall weights by turning auto tally on in
livestock mode (see page ) or by pressing the enter button, but otherwise it simply displays the
weight placed on the load cells. On screen drafting can also be done in livestock mode. The
weigh modes can be changed (see weigh modes on page 20), but no individual data can be
entered. Other weighing options will prompt for an ID to be entered so that the weight can be
recorded.
Draft only - Draft only mode also doesn’t record individual weights, but does generate
statistics for each draft direction. 2 to 7 way drafting can be performed based on weight only.
The ES6000 can have an optional connector fitted so that it will control a mechanical drafting
device such as the sheep autodrafter. In draft only mode with the autodrafter connected, the
ES6000 waits for a signal from the drafting mechanism before proceeding to weigh another
animal. Statistics will be gathered on the overall weighing session and on each draft position, but
no individual weights will be recorded. Point set programming can also be done. This mode is
equvalent to the Thunderbird PS3000 operation.
ID and Weight - Individual weights are recorded against the ID and stored for later
downloading onto a computer. There are 3 IDs allowed on each animal, see page 18 for details
on these IDs. At least one ID (electronic, visual or local) must be entered before the scale will
proceed to weigh another animal. If no ID is present, you will be prompted to enter one. F6
(record) must be pressed to record the weight after the ID has been entered, unless auto tally is on
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and a tag reader is connected, in which case the entering is done automatically. See page 18 for
more information on data entry in this mode.
ID and Draft - This mode is a combination of operating modes 2 and 3. Up to 7 way
drafting with a drafting mechanism can be performed using either weight, weight gain, ID or
manual. Drafting on ID can be either pre-loaded from a computer, or manually decided by
pressing an appropriate number on the keypad. An ID must be entered before the drafting
decision takes place. Statistics are recorded as well as the drafting decision if drafting is done.
See page 24 on how to set the draft settings.
Computer Communication - In normal operation the ES6000 constantly monitors the load
cell(s) connections and reports an error is something goes wrong. This mode disables the
monitoring and allows the ES6000 to be connected to a computer without a load cell being
connected. Weighing also ceases in this mode. You can still check and edit recorded data, and
view statistics. This mode must be selected to upload and download data to a computer. Page 32
explains the computer communication more fully, and there is help information with the
Thundersoft software.

File No. Entry
If “ID and weight” or “ID and draft” was selected, you will be asked for a file number. The
current file number will be shown, as can be seen in Figure 5.

Figure 5: File Number Entry

The ES6000 can store records in up to 100 files. You may type in a number in the range 1-100,
or keep the current file number by just pressing ENTER. If you need to see what file numbers
have been used, press F6, and the file numbers “IN USE” will be displayed. If you make a
mistake in typing, just press the LEFT arrow key.

Livestock Weighing Display
The livestock weighing screen displayed in figure 6 shows the data fields you can use for each
animal. The data across the top of the screen is handy information on the settings of the indicator. The operating mode is in the top left hand corner. This figure shows mode 4 operation,
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Figure 6: Mode 4 Weighing Display
which is “ID and draft”. The operation mode values are taken from your selection in the main
menu. These modes are:
Mode 1 - Weight only
Mode 2 - Draft only
Mode 3 - ID and weight
Mode 4 - ID and draft
The file number is the number you selected before weighing. The number after the file number
on the top line is the number of records in this file. The number in brackets is the total number of
records in memory. The file No. and record count across the top of the screen won’t be
displayed in operating modes 1 and 2.
The weighing mode is displayed in the top right hand corner of the screen. It will show either
livestock or livestock locking in this display. In livestock weighing, the displayed weight may
change if the ES6000 detects any change in the animal’s weight. Such changes might include
when the animal leans against the side of a fixed race for example. Livestock locking mode only
displays the weight once a stable weight is determined. Any change in weight won’t be displayed
unless it exceeds +/-5% of the displayed weight. An example of this sort of change is if the
animal had one hoof on the ground instead of the weighing platform, or if the animal was slow in
getting onto the weighing platform. The weighing mode can be changed in the mode menu by
pressing F3(mode).
If an operating mode that requires an ID has been chosen (mode 3 or 4), the bottom half of the
screen will have locations for entering data on the animal. In modes 1 and 2 the bottom half of
the screen will be blank.
Up to three 16 character identifiers can be associated with each animal in the ES6000. This
allows maximum flexibility in the yards, and avoids your personal ID numbers being mixed up
with the electronic and NLIS IDs when you are listing them on your computer. If you are
recording individual animal weights, at least one ID must be entered before the weight can be
recorded. You may type in each ID, or use a reader to automatically enter the ID. The cursor
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will default to the LID field for data entry.
When you enter an ID, the ES6000 will search its memory for any record that matches this ID,
and display all of the relevent data if a match is found. Any one of the 3 IDs can be entered and
the ES6000 will search based on this ID. If no match can be found, “NEW RECORD” will
automatically be inserted in the comment field.
Note: When manually entering an ID, the cursor must change lines by pressing ENTER, UP
arrow or DOWN arrow before the ID is accepted and a search done. This also applies
before F6 (record) can become active.
EID - The EID (electronic identification or RFID) is the number that is stored electronically in
the NLIS eartag. This is merely a number which that has programmed into a small silicon chip
and can be used for any purpose, in this case an animal eartag. It isn’t displayed on the tag, or
listed anywhere else except in the “tag bucket file” that you can download from the NLIS
website. The NLIS associate this number to their VID so that the VID can be read electronically.
VID - The VID (visual ID or NLIS ID) is a number generated by the NLIS that contains the state
identifier, your property code, and a 5 digit number unique to each animal on your property. This
is the number printed on the NLIS tags. The ES6000 will display this number if your tag bucket
file has been uploaded into the scale before the weighing session, and the tag read by the tag
reader is listed in the tag bucket file. You must enter the full 16 characters of the VID if you
are typing it in manually. The reason for this is that it is possible to have several animals with
the same 5 digit number if you buy and sell, and the ES6000 needs to know which animal it is
when it searches through its memory.
LID - This stands for local ID. You can use this field to record any name or management tag you
have personally given the animal, such as “daisy”, or “B283”. It can provide a link between the
NLIS number given to an animal and your personal records in your computer at home. If you
enter a LID, make sure the 1st character is not a space, otherwise a search based on this ID may
not be successful.
Warning - If an electronic tag reader is used, scan the tag before entering a local ID, otherwise
the ES6000 will reject the scanned EID.
Code - The code field is available in livestock weighing modes when an ID is recorded for you to
enter codes of your choice. For example, you might want to enter “D” for drenched, or “P” for
pregnant, rather than writing a complete word. This code is downloaded to a computer later for
viewing. Up to 12 characters may be entered in this field.
Breed - You may enter the breed of the animal here for record keeping. The breed can be up to
10 charcaters long.
Sex - Any one character may be entered in this field. For example, you might want to use “S” for
steer, or “W” for wether.
Comment - Up to 24 characters may be entered in this field at one time. You may use this field
for any information. If an ID is entered that is not in memory, “NEW RECORD” will be
automatically inserted in this field. You may delete the “NEW RECORD” entry if you wish.
W - This field cannot be altered. It’s purpose is to indicate the number of weighings in memory
for this animal. Up to 10 weighings can be stored in memory for each animal.
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F keys - Each F key has an assignment in this display as shown in Figure 6. F1, F2 and F3 will
lead to another menu. F4(cancel) will abandon any data entered into the fields, and clear all
fields. No weighing will be recorded against any ID that is displayed. F5(history) will open
another screen that shows past weighings for the animal. See page 27 for more detail on the
history. F6(record) records any information on the screen and clears the screen ready for the
next animal.
The weight is recorded when F6 (Record) is pressed, unless auto tally is on, in which case the
weight is recorded when a stable weight is recognised. The weight will also be added to the
statistics at this time.
If the operating mode selected is either mode 3 or 4, you must have at least one ID entered
before the ES6000 will allow you to move on to another animal. The rest of the fields don’t have
to be filled. The date of the weighing will be recorded automatically.

General and Fine Mode Weighing Display
The screen shown in figure 7 is shown when either general or fine weighing mode is selected.

Figure 7: Mode 2 operation

General mode - is designed for weighing non-moving objects, such as feed bins, silos, bags of
grain, etc. Neither statistics nor drafting are done in this mode. However, visual or automatic
point set programming can be performed if drafting has be turned on. Zero weight tracking is
enabled.
You can automatically control equipment such as augers in this mode if an autodraft socket is
fitted. Up to 4 separate pieces of equipment can be controlled with extra control gear. This is
called point set programming. An example of this is if you are weighing a mixing bin. You can
fill the bin with an auger to a certain weight with 1 substance, have that auger turn off and another auger turn on to continue filling to another weight with a different substance, and so on.
See page 35 for more information on point set programming.
Fine mode - is designed for weighing relatively light objects, such as fleece. A maximum of
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50kg can be weighed in fine mode.
Zero tracking and weight tracking are turned off and the displayed weight increments are smaller
in fine mode. Because of this you may notice a small change in the weight for a time after the
scale is turned on. If you want to weigh accurately, turn the scale on 10 - 15 minutes before
weighing. This will allow the electronics to warm up and stabilize.
NOTE: Weighing errors increase on all scales if the weight is only a small percentage of the load
cell capacity. If you want accurate weighing on light weights, it’s best to use load cells with a
small capacity. For example if your main object is to weigh fleece, use a load cell with 50 or
100kg capacity. Load cells with 2000kg capacity won’t be as accurate when weighing a fleece.

Mode Menu
The weighing mode and various other features can be selected by this menu. The F key
assignments will change dynamically as the cursor moves to each line in this display. Figure 8
shows the layout of the screen. F1 can be pressed at any time, and any changes made in this
menu will be saved automatically.

Figure 8: Mode menu

Weigh Mode - If the cursor is on this line the weigh mode can be changed by pressing one
of the F keys. There are 4 weighing modes in the ES6000, selectable in the mode menu. It’s
fairly important to select the correct weighing mode for the application. Using general mode to
weigh cattle for instance will give you a changing weight display that won’t be accurate and will
be hard to read. The various modes are described as follows:
Livestock - Livestock weighing mode compensates for any movement by a damping
system that filters out sudden changes in weight, and averages many weight samples over a
couple of seconds. The weight must be relatively continuous for a time before the weight is
displayed. The displayed weight will change if the indicator determines that the weight isn’t
quite right. Zero and weight tracking are incorporated into this mode.
Livestock Locking - Locking mode works the same as normal livestock mode, except that
once a weight is displayed, any change in weight won’t be shown until the change exceeds +/-5%
of that displayed. The indicator will beep to indicate that it has locked the weight.
General - This mode is for weighing static weights and produce. The displayed weight is
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updated every second, and doesn’t have any weight damping. It is suitable for weighing products
that are slowly added to, such as weighing grain being augered into a bin. Zero tracking is
enabled in general mode.
Fine - Fine mode weighs in smaller increments than general, and has a maximum weight of
50kg. It is suitable for weighing fleece or domestic pets. Fine mode is not available in weighing
systems above 2000kg, and works best in systems that are 500kg or less. There is no tracking in
fine mode to allow any minor changes in weight to be displayed. This also means that you may
experience a small drift in weight for the first 5 - 10 minutes after power on while the electronics
are warming up. After this time the weight should be very stable.
Use the F keys to select the weigh mode, then press the down arrow to move down the
screen or F1 to go back to the previous display.
Auto memory - Auto memory is a function that allows the scale to be turned off for the
night or weekend with a weight on the load cells. The weight displayed at the time of turn off is
remembered, and the same weight will be displayed when the unit is turned on next. This
function is useful when weighing wool for example. It can only be selected in general or fine
weighing modes. With auto memory on, the scale can be turned off for the day or weekend, and
when turned back on again it will display the weight that was being shown when it was turned
off. F4 and F5 can be pressed to turn this feature on or off. Use the up and down arrows to move
the cursor to another line, or F1 (back) to return to the previous screen.
Warning! If weight is added or removed while the scale is turned off, this change in weight will
not be indicated.
Auto Tally - Auto tally allows statistics to be accumulated without the need to press a
button. It is a handy way of recording if the beasts or weights are moving in a free flowing
manner. If an ID is required and a reader is connected to the scale, the ID will be recorded along
with the weight. There are limitations, however, when using this mode. These limitations are:
1. One of the livestock modes must be on for auto tally to work. It will not work in
general or fine mode.
2. The true weight might not be recorded if there is a pause of more than 2 seconds as
the animal is moving into the weighing box.
3. Weights that are applied slowly may be recorded incorrectly.
4. If the weight doesn’t change for more than 2 seconds the weight will be recorded.
Once a weight has been recorded, no other weight can be added until the displayed weight
returns to zero. This is to avoid multiple recordings of the same weight. Use F4 and F5 to turn
this feature on or off. Use the up and down arrows to change lines, or F1 (back) to return to the
previous screen.
Units of Measure - The ES6000 is capable of weighing in lb or Kg. Use F4 or F5 to
change the unit of measure. Use the up arrow to change lines, or F1 (back) to return to the
previous screen.

Setup Menu
The setup menu can be accessed from the main and mode screens.
This menu allows you to set up the working environment and other functions for the ES6000.
Figure 9 shows the screen layout. Selecting any menu option or any F key will direct you to
another screen. The menu choices are described as follows:
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Figure 9: Setup menu

Select File No. - A file allows you to segregate a weighing session or a number of animals
so that they can be viewed separately or sent as a batch to NLIS after being downloaded to the
computer. The ES6000 is capable of handling 100 separate files. The file No. can be changed at
any time during a weighing session. All recordings will be put in the selected file until the file
No. is changed again. Animals can also be added to an existing file without affecting the records
already in the file. Press 1 to change the file No.
Set Date - The date can be changed at any time, and any recording after this change will
have this date attributed to them. Press 2 to change the date.
Select Reader - This choice allows you to select the reader connected to the ES6000 from a
list. Each reader has a different communication protocol, so the ES6000 must use the correct
protocol to be able to communicate with the reader. Press 3 to choose the connected reader from
a list. See page 28 on how to connect a tag reader.
Calibrate Load Cells - Calibration should only be required if you know that the displayed
weight is wrong, or if you want to add a 2nd load cell system to the ES6000. In most situations
you should only need to re-calibrate every 2 - 5 years or so if you want the weight to be as
accurate as possible. The ES6000 can be calibrated in the field, so long as you have a known
weight handy. See page 29 to be guided through the calibration procedure. Press 4 to select this
choice.
Set up communication - The communication parameters must be the same for 2 devices to
talk to each other via a serial port. The ES6000 can communicate at a variety of speeds to be
compatible with a variety of devices. You are best to select a fast communication rate such as
57600 baud with a computer so that data exchange takes as short a time as possible. In almost all
situations the communication speed will be automatically set when you select a tag reader.
Set dress percentage - The dress percentage is the percentage used to calculate the carcass
or dress weight. It is calculated as the carcass weight divided by the liveweight, multiplied by
100. This value is typically in the region of 50 - 60%, depending on the type of animal. You can
change this value to suit your herd. The effect of this setting can be seen when you display the
history of an animal.
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F Keys - Use the F keys at any time to move to another screen as indicated on each key.

Drafting
The ES6000 has the ability to visually or automatically draft animals from 2 up to 7 ways.
Automatic drafting is only possible if the optional draft socket is fitted, and a mechanism to
achieve the drafting is installed. In general weighing mode, point set programming is possible if
draft is on.
For draft mode to work, weight boundary settings must be entered. The number of settings
depends on how many ways the ES6000 is to draft. For example, for 2 way drafting only one
setting is needed. Any weight equal to or greater than the setting falls into the high range, if the
weight is lower than the setting, it falls into the low range. For 5 way drafting, 4 weight
boundaries need to be entered.
In visual and automatic drafting, the range that the weight falls into is indicated on the display .
There are up to 4 possible methods of drafting in the livestock modes. They are:
- drafting on weight. This method will draft the animals or objects according to their
actual weight. Weight boundaries must be selected appropriately.
- drafting on weight gain. The ES6000 can calculate the change in weight of the animal
from the last weighing to now and draft according to which has put on more weight during
that time. If there hasn’t been a previous weighing, or if the animal has lost weight, the
animal will be drafted as if it had no weight gain and be directed through gate 1 or low.
- drafting on ID. It is possible to select drafting directions for each animal on your
computer at home, upload the selections to the ES6000, and have them automatically
drafted by a mechanical drafting mechanism through the gate of your choice. The “new
draft” column in the Thundersoft software is used as a reference for this feature. Enter the
gate number you want the animal to go through into this field using the edit animal
window, and then upload all the records to the ES6000. This feature is handy if you want
to pre-select which animals you want to take to market for example. If there is no draft
decision in memory for the animal, it will be drafted through gate 1, or low direction. If the
draft number in “new draft” is higher than the maximum number of ways set in the draft
menu, the animal will be drafted through the highest gate set by the draft menu. For
example, if the number in “new draft” was 6, and there was 3 way drafting set, the animal
will be drafted through gate 3.
-manual drafting. This method requires you to press a number button to according to the
direction you want to draft. The numbers 1 to the maximum number of drafting ways must
be pressed, that is, if 3 way drafting is selected, 3 would be the highest number you can use.
A screen will appear when the draft decision is required asking you to enter the draft
direction. Livestock locking weigh mode will be automatically selected for this method of
drafting, as manual drafting will not work in other weigh modes.
You are automatically required to set up drafting when you select it in the main menu at turn on.
However you can change the settings at any time by going back to the main menu and selecting
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an option that includes drafting.

Draft Menu
There are 2 types of drafting, physical and on screen. If an auto draft socket is fitted, the ES6000
can physically control drafting gates to direct animals. On screen drafting indicates which draft
position the animal’s parameters fall into, and adds the results to the appropriate statistics data, as
well as recording the decision if drafting with ID. Figure 10 shows the draft menu layout. It
gives you the control of how you want the draft function to work. Press F1 to return to the main
menu at any time, the changes you have made will be saved on exiting the display. The draft
options are as follows:

Figure 10: Draft menu

Draft On/Off - Displays the draft status. F5 turns the function off, and F6 turns it on.
Use the down arrow to change lines.
Autodraft (or point set program) - An autodraft mechanism must be connected in
livestock mode or general mode must be selected before entering the draft menu before this
selection will be displayed. Turning this function on enables the ES6000 to physically control a
draft or point set mechanism, depending on the weigh mode. The drafting becomes fully
automated, in that the ES6000 waits for the draft mechanism to complete its task before looking
to weigh another animal. If point set programming is in operation, the ES6000 will control relays
so that a device such as an auger feeding into a bin can be turned on or off. Use F5 to turn
autodraft on, and F6 to turn it off. The up and down arrows put the cursor on different lines. See
page 34 for autodrafting and point set programming.
Draft On - There is a choice of 4 different criteria that can be drafted on. The choices are
weight, weight gain, ID and manual, and are assigned to an F key. Different data will be
displayed below the choices after selecting the number of ways, depending on what you are
drafting on. See page 23 for more information on the types of drafting. Press the F key of your
choice to change the draft criteria. The up and down keys move the cursor to a different line.
No. of ways - You can choose from 2 to 7 way drafting. If a draft mechanism is attached to
the ES6000 the number of ways should match the mechanism. Select the desired number using
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the numerals on the keypad. The up and down arrows put the cursor on a different line. If
drafting by weight or weight gain, the down arrow will bring up one or more weight boundaries
to set.
Set weight (or weight gain) - This will display the current draft weight barrier between the
1st and 2nd draft gate. Enter the desired weight for each weight boundary, then press ENTER.
Weight settings must be in ascending order (for example, draft setting 2 must have a higher
weight value than draft setting 1).

Search Menu
The search menu gives you a choice of ways to look for a record. You can browse if you don’t
know the ID, or if you do know it, you can directly enter the ID in question. Figure 11 shows the
search menu layout. This is also where you can delete one or more records. The choices are
described below:

Figure 11: Search menu
Browse a file - If you know the file number that the ID is in, you can enter the file number
and search for it. This saves you looking through the entire memory for the record you want.
press 1 to select this search option. You can only browse down the list, if you need to look back
up the list you will need to return to the browse menu and start again. Use the down arrow to
select the next page of IDs.
Browse all records - If you can’t remember the ID exactly, you can use this choice to
search all the records in memory. It will take some time however if there are a lot of records in
memory. Press 2 to select this option. You can only browse down the list, if you need to look
back up the list you will need to return to the browse menu and start again. Use the down arrow
to select the next page of IDs.
Find and/or edit a record - Select this option if you know the ID of an animal and the
exact record will be retrieved. You will then be prompted for the ID. Press 3 for this choice. A
screen will appear asking for the ID to find. Enter an ID in any one of the fields, the search will
be conducted on this ID.
Delete a record - This option will allow you to delete individual animal records.
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Confirmation of this selection will be required before the action is taken. Press 4 for this choice.
Delete a file - All animals in a particular file will be removed from the file with this option.
It’s important to note that the match between the EID and VID (tag bucket file) is not removed if
this option is selected, only the reference of the animal to this particular file. If an animal in the
file is called up at a later date it’s life details will still be present. Press 5 for this choice.
Delete all records - All animal records and details are deleted with this option. Only use
this option if you plan to re-load the tag bucket file afterwards, as the EID and VID matches are
also deleted. Press 6 for this option.
F keys - You may navigate to other screens specified by the F key assignments at any time.

Statistics
Statistics may be accumulated on animals or objects weighed. The recorded weight is entered
into an overall statistics collation, as well as draft statistics if draft mode is on. There are up to 7
sets of draft statistics plus overall statistics, depending on how many ways the draft mode has
been programmed for. This means that there are up to 40 separate draft statistical values
recorded. All can be viewed on the one screen.

Figure 12: Statistics report
All statistics are remembered when the ES6000 is turned off, provided it is turned off using the
on-off button. The statistics will not be saved if the battery is simply unplugged while the
internal battery is flat. This applies also if the battery lead is accidentally disconnected. Saving
the statistics is to allow a break in a weighing session, and then continue with the same session at
a later time. The statistics must be cleared if a new weighing session is to be recorded.
Otherwise the weights will be added to the old statistics.
There are 5 distinct values recorded for each range of statistics. They are:
number weighed
minimum weight
maximum weight
average weight
total weight
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There are 2 ways of adding to the statistics. They are:
1. Manual entry. F6 must be pressed each time a weight is to be added to the statistics.
The weight may be added in any weigh mode, and only the weight displayed at the time will be
added. This method will not work if auto tally is on. 2 beeps will be heard to confirm that the
weight has been entered into the statistics. The displayed weight must return to zero before
another statistic can be added.
2. By autotally. Autotally will only work in a livestock mode. The weight first displayed
will automatically be added to the statistics. There will be 2 short beeps to indicate that the
weight has been recorded. If livestock locking mode is on, there will be 3 beeps, 1 for weight
lock and the other 2 for the weight recording. Any subsequent change in the display will be
ignored until the displayed weight returns to zero. Autotally then re-arms to record the next
weight.
Warning! The weight recorded may not be the true weight if the beast pauses while moving on
to the scale using autotally, or if the weight is applied slowly in increments. There is also no way
of skipping an unwanted weight unless autotally is turned off.
When the stats is selected by an F key, the draft statistics report is displayed. The complete
statistical data will be displayed in columns as shown in figure 12. This report shows the number
weighed, and minimum, maximum, average and total weights for each range. The report
includes the normal statistics, plus all the relevent draft statistics if draft is on. These values
cannot be altered.
In the statistics screen you may elect to go to the main menu by pressing F1, to the previous
screen by pressing F2, or reset the statistics by pressing F5.
The F3 key allows you to view the statistics on a selected file. These statistics are obtained from
the data recorded in the file, and cannot be cleared unless the file is deleted.

History Display

Figure 13: History display
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The history of an animal can be accessed from the livestock weigh screen by pressing
F5(history). Up to the last 10 weighings plus the current weight can be displayed on each
animal. Figure 13 shows the history display. The date of weighing, weight, weight gain, daily
gain and dress weight are all displayed. The dress weight is calculated from the dress percentage
that has been set in the setup menu.
Press F3 (back) to return to the previous display.
This display is only accessible from the livestock screen when recording ID and weight or ID and
draft.

Connecting a Tag Reader
The ES6000 needs to be told that a tag reader is connected. The reason for this is that there are a
number of different communication protocols that tag reader manufacturers use, and the ES6000
needs to know which protocol to use.
To access the reader menu, go to the main screen. From there press F4 (setup), then press 3
(select tag reader). Make your choice from the list. The ES6000 will display “RDR” on the right
hand side of the weigh screen to indicate that a reader has been set up. If for some reason the tag
reader connection is lost, “RDR” will disappear from the weight screen. It will automatically reappear if the connection is re-established.

Select Reader Menu
The ES6000 is configured to allow communication with several different eartag readers. Each
reader has its own communication protocol, so if yours is not on the list, you might have to
experiment with different selections to see if there is one that matches your reader’s protocol.
Figure 14 shows the Reader Menu screen.
Make sure the reader is plugged into the ES6000 and turned on before making your choice.
Some readers require an initialisation sequence to set the communication up properly. For

Figure 14: Select reader menu
29

example, the Thunderbird PR20 needs to have a file number entered and have “ready” displayed
on the screen before it can communicate.
Enter your choice of reader, then eith er press F2 to go back to the main screen, F3 to go back to
the previous menu, or F5 to weigh. If the wrong number is pressed, press either F1 (backspace)
or the left arrow key to wipe the key entry.

Bluetooth Communication
Some readers are set up to communicate via bluetooth instead of a cumbersome lead between the
scale and the reader. The ES6000 will can communicate with these readers by having a “serial
bluetooth adaptor” plugged into the reader socket. The ES6000 has 5V available on pin 9 of the
reader socket (socket on the far right of the base) to power the bluetooth adaptor.
In most cases you will need to configure the bluetooth communication. All bluetooth devices
have a unique internal ID number. One bluetooth device must become the master, and the other
the slave when the communication is set up. The devices must be set to recognise each other’s
ID before they will communicate. This is usually done by using the software that comes with the
device.
Note: There are different types of serial bluetooth adaptors. Some are designed to communicate
with each other only by the setting of “DIP” switches. These types don’t usually come with
software, and so can’t normally be set to communicate with readers that have built in bluetooth.

Calibrating the ES6000
The ES6000 can be calibrated in the field. Each load cell in the system is calibrated individually.
To perform a calibration, you will need to remove all weight, including the platform or crush
from the load cell(s). You will also need a known weight that is a minimum of 5% of the
capacity for multiple load cell systems, and 10% of the capacity for single load cell systems. The
calibration will be more accurate if the known weight is closer to the capacity of the load cell.
The one ES6000 indicator can be calibrated with up to 2 different load cell systems. The
parameters for each system are stored in the ES6000’s memory. Each load cell system may be
calibrated independently of the other, so calibrating one system will not affect the calibration of
the other.
Calibration mode can be entered by choosing option 4 in the setup menu. See page 21 on how to
get into the setup menu. It will also be entered if the calibration was not completed when the
ES6000 was last turned off.
A screen will appear as shown in figure 15. This shows the parameters of the current calibration
for the 2 possible load cell systems. You will also see a menu for the available options. Choose
option 1 or 2 to calibrate the appropriate system.
A warning will appear indicating that if you proceed further you cannot cancel the calibration.
The ES6000 must be calibrated if you proceed further. If you turn the ES6000 off during the
calibration, you will have to do the complete calibration procedure when you turn it back on
again. In fact, if you make a mistake during the calibration, turn the ES6000 off, then restart the
calibration when you turn it back on. Once you enter the calibration procedure a new display will
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appear asking for the system capacity.

Figure 15: Calibrate load cells menu
Enter the system capacity. This is the total capacity of the entire system, not the capacity of each
load cell. For example, if you have 4 load cells of 1000kg capacity each in the system, you will
need to enter 4000kg as the capacity. The maximum capacity the ES6000 can handle is 8000kg,
and the minimum is 50kg.
You will be asked for the number of load cells in the system. Enter this and press ENTER.
Warning! If the load cells are an old style Thunderbird system with linked bars and have a plug
adaptor lead, enter this system as only having 1 load cell.
The ES6000 calibrates individual load cells one at a time. You will need to know which load cell
is which. This can be worked out from the load cell sockets at the base.

DC socket

Computer
socket
Figure 16: ES6000 connections

Load cell 1

Load cell 2

Reader
socket

Load cell 1 is always connected to the left hand socket (looking at the display), as shown in
figure16. If 2 load cells are linked and connected to the left hand socket, load cell 1 is the load
cell with 2 leads connected to it (the lead to the indicator and the lead to the other load cell).
Load cell 2 will depend on the way the load cells are connected. If the load cells are linked
together as described above, load cell 2 will be the load cell with 1 lead connected to it.
Otherwise it is the load cell connected to the right hand socket.
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For a 4 load cell system, load cells 1 and 2 will be linked and are connected to the left hand
socket as decribed above, and load cells 3 and 4 will be connected to the right hand socket. Load
cell 3 is the load cell with 2 leads connected to it, and load cell 4 is the load cell with 1 lead
connected to it.
From here on, follow the on-screen prompts. You must remove all the weight, including any
platform, when it asks to remove all weight. Make sure also that the test weight is still and stable
during the weight reference stage of the calibration.
At the completion of the calibration, remove the weight from all load cells before pressing
ENTER. The ES6000 does a tare straight after the calibration procedure.

Figure 17: Communication mode menu

Adding a Second Load Cell System
The ES6000 is capable of storing the calibration parameters for 2 load cell systems. You may
want to have 2 separate systems, one for weighing fleece in the woolshed and one for weighing
sheep in the yards for example, and not have the expense of having 2 indicators.
To add a system, select option 4 (calibrate) from the setup menu. See page 21 on how to get into
the setup menu.
This will take you to the calibrate main menu. You will notice the parameters for 2 load cell
systems, the 2nd of which will indicate that it’s not calibrated. Choose option 2 to calibrate
system 2 as described in “calibrating the ES6000” on page 29, and a 2nd system will become
available.

Swapping Load Cell Systems
This feature is only available if there are 2 calibrated load cells systems in the ES6000’s memory.
To swap load cell systems, select option 4 (calibrate) from the setup menu. See page 21 on how
to get into the setup menu.
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This will take you to the calibrate main menu. Choose option 3, and the other system will
become the default system. This will remain the default system even after turn off. You must
swap systems again to revert to the other load cell system.

Deleting a Load Cell System
This feature is only available if there are 2 calibrated load cells systems in the ES6000’s memory.
You can only delete the system that is not in use at the time.
To delete a load cell system, select option 4 (calibrate) from the setup menu. See page 21 on how
to get into the setup menu.
This will take you to the calibrate main menu. Choose option 4, and the system not in use will
be deleted.

Computer Communication Mode
The ES6000 constantly monitors the load cell(s) connections and reports an error is something
goes wrong during normal operation. Communication mode disables the monitoring and allows
the ES6000 to be connected to a computer without a load cell being connected. Weighing also
ceases in this mode. You can still check and edit recorded data, and view statistics. This mode
must be selected to upload and download data to a computer. Figure 17 shows the options
available in communication mode.
If you only need to communicate with a computer, you don’t need to press any more buttons on
the ES6000. It’s waiting to respond to any command from the computer while this screen is
displayed and will automatically respond.
When animal records are upload into the ES6000, it doesn’t put them into a file. Instead they are
put into memory to be searched for when weighing occurs, and will be put into the file that is
current when the animal is weighed.
Press 1 if you want to set up the communication. This selection allows you to change the
communication speed and method. The default communication speed is 9600, but you can
increase the speed for a faster download. Caution - the ES6000 communication speed and the
computer speed must match, otherwise data transfer will not occur.
You will be able to see what file numbers are in use if you press 2. This enables you to choose a
number that is free so that you don’t inadvertently add records to an existing file.
Option 3 allows you to browse through all the animals in a particular file number. You will be
asked for a file number to browse. Note that when you browse record, you can only scroll down.
You cannot scroll up the list. If you need to look back at the top of the list, exit the browse
screen, then browse again.
Option 4 allows you to browse all records in memory. Note that when you browse record, you
can only scroll down. You cannot scroll up the list. If you need to look back at the top of the list,
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exit the browse screen, then browse again.
You can view the current statistics by pressing 5. See page 26 for more information on statistics.
Note - You must turn off the ES6000 to exit the communication mode.

Error Messages
The ES6000 has a very comprehensive self monitoring system that detects any problems that may
occur. Should such a problem be detected, an error message will be displayed on the screen, for
example “Error 36”. Most error messages displayed concern problems with the signal coming
from the weigh bars or load cells. The signals from the sensitive strain gauges are extremely
small. The maximum signal from a load bar that has its rated capacity weight applied is
approximately 0.01 volts, and the signal from a 1kg weight on a 2000kg system is less than 0.5
microvolts.
Overload - Each load cell is sampled independently many times per second, which allows the
ES6000 to continuously monitor any problems that could occur. One of these problems is an
overload condition. Any bar that is overloaded will be displayed, even if the overload only lasts
for a fraction of a second. This feature enables the user to minimise possible damage and ensure
a more reliable weight, as well as extending the useful life of the scale.
If an error message is displayed, turn the indicator off, and closely inspect the cables connecting
the weigh bars or load cells. If there is a cut in the outer sheath, or a squashed section of cable, it
may have to be replaced. If all is OK, try turning the indicator on again. The error may be
temporary and clear itself.
If there doesn’t appear to be any visible damage after inspecting the installation and the error
message keeps re-occurring, contact your supplier or distributor, quoting the error number that
appeared. They may be able to help with a cure. Some recurring error problems may be cured by
performing a calibration (see page 33).

Increments
The ES6000 displays in varying weight increments, depending on a number of factors. These
factors include the capacity of the system, the weighing mode, and the amount of weight applied.
The guide below shows the increments used for the displayed weight.
If system capacity is 200kg (440lb) or less;
General0.1kg (0.2lb)
Livestock- 0-50kg, 0.2kg; 51-200kg, 0.5kg
0-100lb, 0.5lb; 101–400lb (1lb)
Fine0-50kg, 0.05kg
0-100lb, 0.1lb
For 201kg (441lb) to 2000kg (4400lb) systems;
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General –

0-200kg, 0.5kg for systems over 500kg, otherwise 0.2kg;
201-1000kg, 0.5kg; >1000kg, 1kg
0-440lb, 1lb for systems over 500kg, otherwise 0.5lb;
441-2200lb, 1lb; >2200lb, 2lb
Livestock- 0-100kg, 0.5kg; 101-500kg, 1kg; >500kg 2kg
0-200lb, 1lb; 201-1200lb, 2lb; >1200lb, 5lb
Fine0-50kg, 0.1kg
0-100lb, 0.2lb
For systems over 2000kg (4400lb);
General-

0-1000kg, 1kg; 1001-4000kg, 2kg; >4000kg, 5kg
0-2200lb, 2lb; 2201-8800lb, 5lb; >8800lb, 10lb
Livestock- 0-200kg, 1kg; 201-2000kg, 2kg; >2000kg, 5kg
0-440lb, 2lb; 441-4400lb, 5lb; >4400lb, 10lb
There is no fine mode selection on these systems.

3 Way Autodrafter (Optional Equipment)
A 3 way drafting mechanism is available from Thunderbird that will automatically draft sheep,
goats or pigs. One person can draft up to 600-700 animals per hour without touching the
ES6000. No remote controls or any external controlling devices are required, all gates open and
close fully automatically.
The autodrafter mechanism requires a 12V battery and a minimum of 30psi compressed air at 2cu
ft/min to operate. Any small air compressor should be able to deliver this amount of air.
The drafter mechanism and weigh bars must be mounted onto a concrete slab or rigid steel
structure for it to operate reliably. See page 3 for more information about installing the load bars.
It is also highly desirable that hop bars be installed in the race leading up to the drafter. The hop
bars will prevent the animals from slamming into the rear gate of the drafter, and also smooth the
flow of animals into the drafter. 2 - 3 hop bars should be placed at roughly knee high to the
animal, and about 1 animal length apart.

Operating the Autodrafter
1. Connect the air compressor to the drafter and turn it on.
2. Connect the drafter to the ES6000 and turn the scale on.
3. Connect a 12V battery to the drafter control box.
4. Set the switches on the draft control box to auto.
5. Set up the draft parameters in the ES6000. Drafting can be done on weight, weight gain,
ID or manual, but only by weight in operating mode 2. Set the ES6000 to operating mode
2
or 4, depending whether you want to utilise the animal ID. Make sure the draft
number of
ways in draft set up doesn’t exceed the number of gates on the autodrafter. The
ES6000
must be in one of the livestock weighing modes before it can control the
autodrafter. See
page 24 for more information on setting up the drafting parameters.
6. The unit is ready to operate.
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You can manually override the gate control by using the switches on the draft control box at any
time. Just move the desired switch to manual to control the particular gate. Put the switch back
to auto to let the ES6000 control the gate again.
The rear gates automatically close behind the animal when it enters the drafter. After a few
seconds the chute direction gates will be set, followed by the front gate opening. When the
animal leaves the autodrafter the rear gates will automatically open again.
Note: Lubricate the air lines with a very small amount of light oil daily, and regularly check the
filters on the air solenoids. Remove and clean the filters if necessary.

Point Set Programming (Optional Socket)
The ES6000 is able to control other devices based on weight if the optional socket is installed.
For example, you might want to mix a feed ration of a few different ingredients in a certain ratio.
The ES6000 provides the signals to control up to 4 augers as a bin fills up.
Note: External electrical wiring and relay control is required before point set programming can
be utilised (not supplied by Thunderbird). Contact Thunderbird for a wiring diagram. One of the
outputs is a zero weight indication, and can be used to initiate a sequence.
The weigh bars should be mounted underneath the bin or container that the product is to fill. If
the container is a mixer or is large, it’s desirable that 4 load cells or load bars be used for stability.
See page 3 on installing load bars.

Using Point Set Programming
1. Connect the ES6000 to the electrical control device and turn both on.
2. Set the ES6000 draft parametersa) Operating mode 2
b) Weigh mode set to general
c) Set draft parameters; draft on, point set programming on, appropriate number of
ways and weights.
3. Start weighing.
Point Set Programming will be indicated on the display, as well as the output decision.
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Indicator

Specifications

Input Voltage: ............................ 12Vdc nominal
Internal Battery: ........................ Ni-MH rechargeable 7.8V nominal
Battery Capacity: ....................... 3000mAH
Operating Current: .................... 150mA (approx, no load cells connected)
Display: ..................................... 240 x 128 dot graphic
Weight Digit Size: ..................... 36mm (approx)
Keypad: ..................................... 53 keys tactile feel
Memory Capacity: ..................... 50,000 animal records, 10 weigh sessions each
Analogue Inputs
No. of Analogue Inputs: ............ 2 standard (4 optional), sensed independently
Analogue Input Requirement: ... Strain gauge in full bridge configuration
Analogue Input Voltage(s): ....... 0-10mVdc
Analogue Input Offset:.............. +/-25mV maximum
Accuracy: .................................. >99% at full scale
Load Cell Supply Voltage: ........ 5Vdc
RS232 Connections
RS232 Physical Protocol: ......... 8,N,1, no flow control
RS232 Baud Rate: ..................... Selectable 9600(default), 19200, 38400, 57600
RS232 Power Pin: ..................... 5Vdc on pin 9, maximum 200mA
Autodraft Socket (Optional)
No. of Outputs: ......................... 7
No. of Inputs: ............................ 2
Type of Output: ......................... N/O, all switching to pin 1
Output Rating: .......................... 12Vdc 500mA maximum per output
Output Snubbing: ...................... User must fit diode across any inductive load
Input Requirement: ................... Voltage free switch contact
Physical
Dimensions (mm): .................... 237(w) x 172(h) x 78(d)
Weight: ...................................... 1.4kg
IP Rating ................................... IP24 (provided indicator is at 45 degrees or more)
Mounting: ................................. Bracket with “U” bolt

Load Bars
500kg and 2000kg bars
Sensitivity: ................................ 2mV/V (approximate)
Gauge Resistance: ..................... 350 ohms
Body Dimensions (mm): ........... 580(long) x 95(wide) x 95(high)
Weight: ...................................... 8.4kg
Mounting Hole Locations: ........ 4 holes, 480mm x 125mm centred about body centre
3000kg bars
Sensitivity: ................................ 2mV/V (approximate)
Gauge Resistance: ..................... 350 ohms
Dimensions: .............................. 1000(long) x 125(wide) x 105(high)
Weight: ...................................... 20.8kg
Mounting Hole Locations: ........ 4 holes, 885mm x 175mm centre about body centre
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Troubleshooting
Problem
Won’t turn on

Cause

Remedy

Battery not connected

Connect to a charged, 12V battery

Battery leads in reverse

Make sure the +ve clip is on the +ve terminal

Battery lead has been
stretched

The battery lead wires are connected to the
battery clip with a push on connector, this may
be disconnected. Simply push it back onto the
terminal.
Connect an external power source (adaptor or
12V battery) and the internal battery will
charge

Internal battery is flat

Continuous beep and Internal battery is flat
won’t turn on

Battery voltage is below the threshold for the
indicator to turn on. Charge the battery.

Won’t tare

Moving weight

The weight must be still and stable before the
indicator is able to obtain a tare reading, make
sure any weight still on the load cells does not
move.

Poor installation

The load bars must be installed on a solid base
such as concrete. Sitting them on the ground
is not satisfactory. Refer to the installation
section.

Flexible platform

Any platform that may be used on top of load
bars must be rigid, and must spread the load
over the entire bar. Timber panelling is not
acceptable.

Moisture in plug

Moisture is the most common cause of eratic
weights in any scale. If there is moisture in
the plug, undo the plug, and thoroughly wipe
out and dry all parts of the plug before reassembling.

Moisture in plug

Moisture is the most common cause of eratic
weights in any scale. If there is moisture in
the plug, undo the plug, and thoroughly wipe
out and dry all parts of the plug before reassembling.

Poor installation

The load bars must be installed on a solid base
such as concrete. Sitting them on the ground
is not satisfactory. Refer to the installation
section.
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Eratic weight

Won’t record animal Wrong operating mode

Mode 3 or 4 must be selected to record animal
details

No ID has been entered

At least 1 ID must be entered before the
animals details can be recorded

Enter hasn’t been pressed
after manually entering
an ID

Enter has to be pressed so that the ES6000
knows that it has the full ID, otherwise it may
record the details against a different animal
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Serial Communication Problem Flow Chart
Yes

No

Does the computer have a serial port?

Connect the PR20 to the computer

Try a USB - RS232 converter

Start Phoenix

Turn on the PR20

Click on “Get IDs”
No

Does time out occur when getting IDs
Yes
Is the PR20 displaying
“READY”?
Yes

Uninstall Phoenix,
download latest
version, and install it

No

Press ENTER on the
PR20 so that it does

No Is Phoenix 1.2 or
later in use?
Yes
Yes Do the PR20 and Phoenix No
baud rates match?

Don’t
Is the correct COM know
number in use?
Yes

In Phoenix, go into
Tools>Options, click on reader
tab, and check the COM
number (Don’t use COM3)

Was the USB-RS232 converter
installed using its installation disk?
Yes
Have 2 or more USB No
ports been tried?
Yes
Is the computer a laptop?
No
Get serial card CL9820-1S and install it

Set the baud rates so
that they are the same

Yes

No

No
Have all the
COM numbers
been tried?

Select another
COM number
(except 3)

Yes

Remove the USB-RS232
converter and install using
the installation disk

Unplug the USB-RS232 converter
from the computer, wait 5 seconds,
then plug it into another USB port
Does the laptop have an
Express card slot?
Yes
Get CL-EXP0103 and install it

No

Does the laptop have
a PCMCIA slot?
Yes

Get CL-PE101 and CLEXP01-03 and install them

No
Try a different
USB-RS232
converter

Communication OK
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WARRANTY
THUNDERBIRD
Weighing Systems
Thunderbird warrants the ES6000 indicator and associated Thunderbird load cells
against defective workmanship and faulty materials for 2 years from the date of
purchase. We undertake, at our option, to replace or repair free of charge this product, or part thereof, on condition that it is returned to our factory freight prepaid, and
found on examination to be suffering from material or constructional defect. We
cannot be held responsible for any repair other than those carried out by us or our
authorised agents.
A photocopy of your proof of purchase and a request for warranty must also
be returned with the item.
This warranty is void if the product is subject to improper use or handling, incorrect
power input voltage, damage through contact with chemicals, flooding, fire, explosion, excessive heat, lightning strikes, insect damage, moisture damage or damage
to external wiring. Any warranty on load cells will become void if they are found to
have been subject to excessive weight, or failure caused by corrosion due to excessive buildup of manure and moisture.

Country Electronics Pty Ltd
ABN 38 003 806 040
11 Industrial Avenue
PO Box 391
Mudgee NSW 2850
Mudgee NSW 2850
Phone: 02 63723600
Fax: 02 63722597
Email: enquiries@thunderbird.net.au
For your records:
Model No.: ..............................................................................................
Serial No.: ...............................................................................................
Date of Purchase: ....................................................................................
Place of Purchase: ...................................................................................
Receipt No.: ............................................................................................

